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Conventions used in this document

Menu options

The notation File >> Exit means select the File menu and the select the Exit option.

Buttons

The notation [Add] is an abbreviation for ‘the button labelled Add’.

Cross references

The notation <2.5> means see section 2.5
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1 Introduction

eBK –  an electronic book kit – is primarily designed to take documents which conform to the Open
Document Text format and use them to create an electronic book (ebook) that adheres to the ePUB
format.  Such ebooks can be read using computer software or using many of the currently available
ebook readers.  The  Wikipedia entry on ePUB gives more information on the ePUB standard and on
compatible ebook readers.  eBK comprises two tools:  ODTConverter and  eBKBuilder which we will
refer to as Converter and Builder respectively.

1.1 Converter

Converter takes an Open Document Text (ODT) and converts it to HTML1 or more precisely XHTML 1.1.
The output from Converter is one or more HTML documents and a single Cascading Style Sheet (CSS).
Although Converter can be used to produce a single HTML document its main purpose is to produce a
set of HTML files and a CSS file from which an ePUB electronic book (ebook) can be created possibly
using Builder.

1.2 Builder

An ePUB ebook is a single file – a compressed Zip archive2 containing several constituent files. These
files fall into two broad types. Those which organise the ebook and give it its structure, and those which
provide the content of the ebook – what is read.

Builder takes care of the organising files, but the content must be provided by the author, writer or
other creator of the book. The content of an ePUB ebook is one or more HTML files conforming to the
XHTML 1.1 standard. Most of the information on the World Wide Web – the most familiar aspect of the
Internet – is stored in HTML files, text files set out in the  Hypertext Markup Language. XHTML is a
development of HTML which conforms to the requirements of XML (Extensible Markup Language). Web
pages (in HTML) are produced in a variety of ways and most Web browsers (Internet Explorer, Firefox,
Safari, Opera and so on) have been developed over many years and can handle Web pages that are
written in HTML and XHTML and will more often than not be able to display pages that break some of
the rules. They can also handle things like JavaScript3 and by means of ‘add-ons’ or ‘plug-ins’ can display
dynamic and interactive elements that are not written in HTML or XHTML. The ePUB standard uses
XHTML 1.1 and (at the moment) nothing more for the content of an ebook. Converter provides one way
of creating compliant HTML documents together with acceptable CSS files.

1 HyperText Markup Language – the language which is the basis for all World Wide Web documents.
2 This is like a compressed folder under Microsoft Windows and is a convenient way of storing and distributing a 

collection of related files.
3 Do not confuse Java and JavaScript. They are entirely separate programming languages used for distinct purposes.
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1.3 Limitations and caveats

1.3.1 HTML

The HTML produced by Converter complies4 with the specification of ePUB 2.0 and those features in
ODT which cannot be represented are ignored. These are, in the main, those related to page breaks and
page layout. HTML does not recognise the notion of a page and each HTML document can be as long as
it needs to be. Consequently, the user when viewing it through a web browser may need to scroll down.
Ebook readers5 present the content of the ebook a page at a time with the page breaks being determined
by the size of the display and the size of the font. Thus page breaks do not occur at fixed points in the
text  as  they  do  with  a  printed  book.  HTML produced  by  Converter is  compatible  with  most  web
browsers.

ePUB 2.0 will eventually be superseded by ePUB 3.0 which uses HTML5, the successor to XHTML 1.0. It
expected that the output from Converter will be compatible with ePUB 3.0. Where this proves not to be
so then changes will be made. However, until ePUB 3.0 readers are more common there is no intention
to anticipate such changes.

The limitation to straightforward XHTML 1.1 means that HTML or XHTML files generated by software
systems such as DreamWeaver, or by word processing systems, may be viewed using Web browsers, but
it is possible, even likely, that they will not conform to the strict standards of XHTML 1.1. This means
that the producer of ePUB ebooks must have HTML expertise or access to ways of producing ePUB
ebooks that do not require that expertise. Converter is one way of producing acceptable HTML files

The same limitation has led to criticism of the ePUB standard. The criticism points to the fact that HTML
is biased in favour of content that is mainly words, and words that are in a single sequence with very
little structure and no requirement to be laid out on a page in a particular arrangement – novels rather
than magazines.

1.3.2 Open Document Text (ODT)

The ODT specification is complex and not all  features are relevant to ebooks, so  Converter ignores
much of what is present in the ODT package6. The task of understanding the full specification of an ODT
document  is  difficult.  Converter has  only  been  tested  thoroughly  on  ODT  packages  produced  by
OpenOffice7 which uses the ODT standard as its default format. Many other word processors can export
documents in ODT format and OpenOffice can import the output from word processors such as Microsoft
Word. If you are intent on making ebooks using eBK then it will be easier if you work with OpenOffice
which can be downloaded and installed at no cost. If you prefer to use another word processor then
check that there is a route from your word processor to ODT. Be warned: a sequence of conversions
using different word processors may result in a document that does not quite look like the original.

1.3.3 A note on fonts

You may in  a  CSS stylesheet  specify  a  particular  font  for  all  or  part  of  the  text.  When  an HTML8

document  is  displayed  by  a  web  browser,  the  web browser  attempts  to  display  the  text  using  the
specified font, but it can only do this if the particular font is installed on the computer being used. If the
font is not installed on the computer then the web browser will use a similar font that is available. This is
true when reading ebooks. The only fonts that can be used are those on the computer or reading device.

4 Output from eBK Builder using HTML produced by ODTConverter is accepted by the ePUB Validator (ePUBcheck) 
available through the International Digital Publishing Forum (http://validator.idpf.org/).

5 The term ‘ebook reader’ refers to a device exclusively designed for reading electronic books. There also are 
software ebook readers. What is said in this guide about ebook readers may not be true of software ebook readers.

6 The ODT package appears to the user as a single file, but is in fact a compressed package of many files only one of 
which represents the content of the document.

7 For copyright reasons the official name is OpenOffice.org and the OpenOffice web site is www.openoffice.org
8 This is true of  HTML documents as well. 
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It is possible to include with an ePUB ebook the fonts that the particular book uses, but there may be
restrictions. Certain fonts are restricted so that they cannot freely be transferred to another computer or
computer-like device <2.2.3><4.5>.

1.3.4 A note on colour

HTML documents when viewed with a web browser are usually colourful. At the moment many ebook
reading devices are monochrome (user only white, greys and black)9. A colourful HTML document that is
used in a ePUB book may be colourful when read with computer software, but not when read with a
ebook reader.

1.4 Java

Both Converter  and Builder  are written in Java and in principle run on any computing system that
supports  Java10.  However,  they  has  only  been  tested  in  a  Microsoft  Windows  environment.  The
instructions and examples given in this document assume that you are using Microsoft Windows. In
principle  Converter  and Builder  should  both  run on both  Apple  and Linux  platforms  but  without
confirming  evidence  it  is  suggested  that  it  be  used  with  caution  and  any  problems  reported  to
ebk@senexdomum.co.uk.

1.5 Obtaining eBK and installing the  Java Runtime Environment (JRE)

The installation kit for the latest version (eBKinstall.jar) can be downloaded from

 http://www.senexdomum.co.uk/software/free.html.

You may place it in any convenient folder.

The Java Runtime Environment (JRE) must be obtained and installed separately. It is possible that you
already have JRE installed already. In any case it will be worth visiting the Java web site

http://www.oracle.com/us/technologies/java/overview/index.html

this gives information about Java. At the time of writing you should hover over the Downloads tab and
then select Java for your computer from the long list that appears. This will take you to a page where
you can download the latest  version of  the Java  Runtime Environment  (JRE) and install  it  on  your
computer.

Once you have downloaded the  eBK installation kit  and installed JRE then you can install  eBK as
follows:

• Double click eBKinstall.jar

• Click [Choose installation folder ... ]

• Browse to the folder where you want eBK to be installed

• Close the installer.

You may choose any folder you like for the installation. You may wish to create a new, empty folder as
this will make uninstalling the software straightforward.

1.5.1 Uninstalling eBK

To install eBK delete the files placed in the installation folder during installation. These are:

9 This is a result of the current screen technology used with ebook readers which uses minimal power so that the 
device can be used for a long time without re-charging the batteries.

10 Java (http://www.oracle.com/us/technologies/java/overview/index.html) adheres to the principle of ‘write once, 
run anywhere’.

Date of most recent modification: 2013-09-20 9/48

http://www.oracle.com/us/technologies/java/overview/index.html
http://www.senexdomum.co.uk/software/free.html
mailto:ebk@senexdomum.co.uk
http://www.oracle.com/us/technologies/java/overview/index.html


eBK User Guide

• eBKBuilder.jar

• ODTConverter.jar

• eBK_User_Guide.pdf

• eBK_User_Guide.epub

1.5.2 Uninstalling JRE

You are unlikely to want to do this as it is probably used by other software on your computer. If you wish
to do so then you must follow the instructions for uninstalling registered software by (for example)
opening  the  Control  Panel  and  selecting  Add  or  Remove  programs.  Consult  your  computer
documentation if you are not sure how to do this.
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2 Using  Converter

Before you can begin you need to have at least one document the conforms to the ODT specification.
Ideally this should be a document created with OpenOffice or possibly imported into OpenOffice and
saved as ODT. Throughout this section this document will be referred to as  document.odt though it is
likely that your document has a different name.(There is a a file called  document.odt included in the
download which contains the first three chapters of Oliver Twist by Charles Dickens and can be used as
you work through this manual.)

2.1 Launching Converter

Locate the file ODTConverter.jar on your computer and open it (that is double click the file name). After
the opening splash screen you will see the following window (the version number in the title bar may be
slightly different):

Date of most recent modification: 2013-09-20 11/48
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Here is a clearer look at the menus:

2.2 Converting an ODT document to a single HTML document

Converting a document to HTML using the default settings and options takes two quick steps:

1. Open the document

2. Convert the document.

2.2.1 Opening a document

Select  Open from the File menu. (In the rest of this user guide the following notation will be used to
indicate menu selections:

File >> Open ...
Browse for your source document and click [Open] (i.e. The button labelled Open).

Converter will read and analyse the document and then display a brief summary in the upper part of
the window.

Date of most recent modification: 2013-09-20 12/48
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The lower part of the window will contain the following text (but with, of course, a different file path for
the source document).

C:\Documents and Settings\Ken\My Documents\My Programs\eBK\doc\ODTConverter\document.odt opened.
 ... lists extracted.
 ... summary complete.

This panel is used to notify the user about what has happened. This will be discussed later in more
detail.

2.2.2 Converting the document

Select:

File >> Convert ...
You will be asked to choose a Destination folder – the folder where the HTML file and the CSS file will be
saved. Any folder will do but there are good reasons for creating one especially for this purpose. Browse
to where you would like to create the new folder and use the new folder button to do so.

Select the new folder or the folder you wish to use and click [Convert].

The following text will have been appended to the notification window:

Date of most recent modification: 2013-09-20 13/48
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Exporting conversion to: C:\Documents and Settings\Ken\My Documents\My 
Programs\eBK\doc\ODTConverter\html.
 ... document.odt.html - Oliver Twist : Chapters 1-3.
Exported conversion to C:\Documents and Settings\Ken\My Documents\My 
Programs\eBK\doc\ODTConverter\html\document.odt.html.
C:\Documents and Settings\Ken\My Documents\My Programs\eBK\doc\ODTConverter\html\document.odt.css 
created.
Conversion completed.

Briefly this reports that two files have been created in your chosen folder:

• document.odt.html

• document.odt.css

Close Converter by selecting File >> Exit.

The first of these two files contains the HTML document corresponding to your ODT document, the
second is has all  the related styling information and conforms to the Cascading Style Sheets (CSS)
standard11. There is a link in the first file to the second. To work these two files must be kept together in
the same folder.

2.2.3 Inspecting the HTML document

Browse  to  the  folder  you  chose  as  the  Destination  folder  and  open  the  HTML  document
(document.odt.html)  with your browser.  If  you have OpenOffice  installed  you can open the original
document (document.odt) and compare its appearance with that of the HTML version. One difference
should be obvious – in the HTML document the width of the text area depends on the width of your
browser window, in the original the width of the text is fixed within the margins of the page.

Although  it  is  possible  to  fix  the  width  of  the  text  in  an  HTML document,  when  creating  HTML
documents for use in an ePUB book the width should not be fixed and the width of the text determined
by the ebook reader.  However,  Converter  does recognise  that  the original  document  had  margins.
Converter can work out the percentage of the page width allocated to each margin and sets styles up in
the CSS file to ensure that the HTML page has margins which are the corresponding percentage of the
window width. However, by default, it ignores such margins <4.6.1>.

Another difference maybe the size of the characters. HTML documents may use fixed size characters by
specifying  the  point-size  of  the  font.  However,  by  fixing  the  point  size  the  user  is  prevented  from
enlarging or reducing the size of characters either by enlarging to improve legibility or reducing to see
more of the text.  Converter, by default, converts the point sizes of the fonts to one of the relative sizes
that are more usual in HTML documents. These sizes are:

• xx-small

• x-small

• small

• medium

• large

• x-large

• xx-large

The algorithm used to determine which HTML font size is used has two parameters:

(a) the point-size corresponding to ‘medium’

11 There are several CSS standards. CSS 3.0 is the latest. Most of what Converter produces falls within the CSS 2.0 
standard but some elements are only in 3.0. Software which can only handle CSS 2.0 should ignore CSS 3.0 
elements.
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(b) the ratio between adjacent HTML font sizes.

The default values for these two parameters are: 13pt and 1.2. This means that for a point size of 13 the
HTML size ‘medium’ will be used. The others are determined as follows:

Original Point Size

Less than 9.03 xx-small

Less than 10.43 but greater than or equal to10.83/1.2 (= 9.03) x-small

Less than 13 but greater than or equal to 13/1.2 (= 10.83) small

13 medium

Greater than 13 but less than or equal to 13 x 1.2 (=15.6) large

Greater than 13.8 but less than or equal to 15.6 x 1.2 (=18.72) x-large

Greater than 18.72 xx-large

It  may be that  these default  values do not give the desired result.  The user  may use other  values
<4.5.5> to achieve an acceptable range of font sizes in the converted document.

Fonts will be correct provided that the fonts used in the original document are installed on the computer
(or reading device). Where this is not so a substitute font will be used. The CSS specification makes it
possible to indicate where the font files corresponding to the fonts used are to be found. This in turn
makes it possible to bundle up font files with the HTML and CSS files so that the document is rendered
using the same fonts as in the original document. Font files come in various forms and with varying
restrictions on their distribution. At the moment Converter is able to handle TrueType fonts, but there
may be ways to extend this to other types of font files. When this is done the files which constitute the
font are referenced in the CSS file so that Builder can add them (embed them in) the ePUB ebook
package. It should be noted that font files can be large and embedding them may result in a very large
ePUB file.

Date of most recent modification: 2013-09-20 15/48
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3 An overview of Converter

Before explaining it detail how to use Converter an overview of its functionality will be presented.

3.1 What Converter will do and what it won’t do

Ebooks are different from word-processed documents. Word-processors produce documents for printing
on paper. Ebooks are intended to be read using software on a computer or special-purpose reading
device – an e-reader. Some of the features of a word-processed document either cannot be faithfully
represented in an ebook or it  may not be appropriate to do so.  On the other hand there are some
features of an ebook that are not explicitly represented in a word-processed document and need to be
constructed. However, the bulk of what is present in the word-processed document can be satisfactorily
represented in an ebook. The lists of features that can or cannot be represented or must be constructed
will change as the specifications for ODT documents and ePUB books care developed further. What is
given here is a snapshot of the way things are.

Ebooks conforming to ePUB 2.0 (or earlier) do not have pages as such, nor do they have footnotes.
Converter  ignores pages and turns footnotes into endnotes with an active link to them in the text.
Where a page is divided into columns, the division into columns is ignored. All images or text boxes that
are anchored to pages will be placed at the head of the HTML document12.  Converter  cannot handle
embedded objects which require other software to render. Such software may be present in a computer,
but not in an e-reader. However Converter will handle the following:

• different fonts and different character sizes

• different styles of text: italic, bold, subscript, superscript, small capitals, shadowed, outlined13

• text decoration: underlining and overlining (but only with a single solid line, as this is all that
CSS allows)

• headings (with or without numbering)

• numbered and bulleted lists using different styles of numbering but with a limited set of bullets

• tables

• footnotes, endnotes and annotations (all represented as endnotes in three separate lists)

• images (pictures)  –  the  screen size  of  the  delivery  device  may affect  quality  particularly  in
images that contain text

• text frames (text boxes)

• cross-references

12 If the ODT document has been converted into several HTML documents images and text boxes anchored to pages 
will appear at the beginning of the first document.

13 Although the CSS can specify outlining of text (CSS 3.0) at the time of writing no browser will render it. Whether 
there are e-readers that do is not known. In any case Converter creates the necessary properties in the CSS file 
should there be a device or software that render outlined text.
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3.2 Creating multiple HTML documents

By default  Converter creates a single HTML document from a single ODT document. However, the
ePUB specification allows multiple HTML documents to be used in a single eBook. These component
HTML documents are normally used to represent elements of the book such as chapters. The ePUB table
of  contents is derived from this set of elements rather than relying on a table of contents within (for
example) a single HTML document. There are several ways within the ePUB specification for building
tables of contents. The simplest way is to make every element of the book a separate HTML document.
To facilitate this  Converter will split the output into several HTML documents and a single CSS file.
The locations in the ODT document where a new HTML will be started is determined by one of two
methods:

• at a hard page-break (often in a word-processed document the only occurrences of hard page-
breaks are at the end of chapters or something similar)

• at the point where text in a particular style occurs (most word-processed documents consist of
paragraphs that are formatted according to named styles and one of those styles is likely to be
specific to, for example, chapter or section headings)

You can experiment with this using the example document (document.odt)14. Here is a suggestion:

1. Launch Converter by double-clicking ODTConverter.jar.

2. Select File >> Open ... and browse for document.odt then click [Open].

3. Select Split >> Style ... and when presented with a list of Styles select Heading 1. (This is the
style used for the chapter headings in the document.) Click [OK]

4. Select File >> Convert ... and select the folder where you would like the converted files to be
placed. (This can be the same folder you used earlier).

5. Select File >> Exit

In the destination folder you will now find four files that have been created:

• document.odt.000.html

• document.odt.001.html

• document.odt.002.html

• document.odt.css

The last of these will have replaced the file of the same name you created earlier. (This does not matter
as it will also work with the earlier document.odt.html.)

If  you  open  each  of  the  three  new  HTML  files  you  will  find  in  each  one  a  single  chapter  from
document.odt.

3.3 Building an ePUB ebook

You now have all that is necessary to build a simple ePUB ebook using eBK Builder. Which will have
been installed  when you installed  the  eBK <1.5>.  More details  are  given  in  later  sections  of  this
document.

14 This is supplied as part of the eBK kit.
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4 Converter in detail

In this section every menu entry is described. In doing so some indication is given as to the purpose of
the function associated with the menu entry. However before doing that we will look at the Lists tab.

4.1 The Lists tab

The  main  window of  Converter  has  two  tabs:  Information and  Lists.  The  Information tab  gives
information about the ODT document and reports what Converter has done. The Lists tab gives detailed
information about what Converter has found in the ODT document.  Most of  this can be ignored in
normal use, but there is information present in the Lists which may help in determining why the output
HTML is not as expected. The Lists tab has the following further tabs down the left-hand side:

• Container

• Meta

• Styles used

• Styles declared

• Font faces

• Images

Each of these will be briefly described, but if you want to get on you can skip the rest of this section and
get on with converting your document <4.2>.

4.1.1 Container

Here (in the left-hand panel) are listed all the files found in the ODT package. In the right-hand panel the
same list appears with each item followed by and equals sign (=). To the right of the equals sign is the
mimetype15 of the file.

4.1.2 Meta

This lists the metadata found in the ODT package. Metadata gives keywords and associated values. The
left-hand  panel  has  the  widely  recognised  Dublin  Core16 meta  values,  the  right  hand  panel  those
provided by Open Office.

4.1.3 Styles used

This panel lists all the names of all the styles actually used in the document. The names are arranged in
columns according to the type of style.

15 The Wikipedia article at http://en.wikipedia.org/wiki/Mimetype has more information.
16 The Wikipedia article at http://en.wikipedia.org/wiki/Dublin_Core has more information.
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4.1.4 Styles declared

This panel lists all the names of all the styles declared in the document, but not necessarily used. Again,
the names are arranged in columns according to the type of style.

4.1.5 Font faces

This lists in the left-hand panel, the fonts declared in the document. Where the same actual font face is
referred to by another name then the actual font name is given after the chevron (>>). The centre panel
gives the names of the font faces actually used by your document. The right hand panel gives the names
of available fonts linked into Converter and which will be referenced in the generated CSS file. Unless
you have specified that fonts be linked this will indicate that none are available <4.5.1>.

4.1.6 Images

Displays the images (pictures) used in the document and gives the path (relative to the HTML file) in
which the image is stored, the caption associated with the image, the size (in pixels) of the image, how
many times it is referenced (used) in the document and how it is anchored in the document.

Converter attempts to extract the text from the ODT document which represents the caption associated
with this image. Such text (or “Uncaptioned”) is given as the value of the ‘alt’ attribute of the ‘img’ tag
in the output HTML document. This is required by the EPUB standard, but is use din different ways by
the readers and browsers. The text assigned as the caption may not be exactly what is displayed in the
ODT document.

4.2 The File menu

4.2.1 Open ...

This opens the Open Text Document (ODT document) that is to be converted. Only one document can be
converted at a time, and some options on some menus are not available until a document has been
opened.

4.2.2 Convert ...

This converts the currently open ODT document to one or more HTML files and an associated CSS file.
The names of these files are derived from the name of the original Open Document (ODT) file. If, for
example, the ODT file is called book.odt then the CSS file will be given the name book.odt.css and the
HTML file will be book.odt.html. In the situation where the output is split <4.4> and there are several
HTML files then there names will be book.odt.000.html,  book.odt.001.html and so on. Where the name
of the ODT file contains spaces, such spaces will be replaced by underlines (underscores) to ensure
compliance with current HTML and CSS requirements. Thus, an ODT file with the name my book.odt
will  lead  to  output  files  with  names  of  the  form  my_book.odt.css,  my_book.odt.html   and
my_book.odt.000.html.

4.2.3 Exit

This closes Converter. No warnings are given and Converter is closed whether or not a conversion has
been completed.

4.3 The Settings menu

Settings are all those options or values that have an effect on the conversion process. These values and
options are indicated under the menus Split, Fonts and Options.
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4.3.1 Load ...

This loads settings saved earlier.

4.3.2 Save

This saves the current settings overwriting the settings file that was loaded earlier. If no settings file has
been loaded then this is the same as Save as ...

4.3.3 Save as ...

This saves the current settings in a named file. The name of the file is chosen by the user.

4.3.4 Save with document

This saves the current settings in a file. The name of the file is determined by Converter and is derived
from the name of the current document. When the document is next opened for conversion (because, for
example,  changes  have  been  made  to  the  document)  then  the  settings  saved  in  this  manner  are
automatically loaded when the document is opened.

4.4 The Split menu

The first two options and values determine how a single ODT document may be split into several HTML
documents with a single CSS file. The third one allows the user to specify titles that will be given to
multiple HTML files.

4.4.1 Page break before

If this is selected (ticked or checked) then whenever a hard page break exists in the ODT document then
this is taken to indicate a place where a new HTML output document should be started. A ‘hard page
break’ is one inserted by the user to force the start of a new page; it is not the page break inserted when
a style indicates that the next paragraph must begin on a new page. (May be used in conjunction with
Style ....)

4.4.2 Style ...

This allows the user to choose one or more paragraph styles used in the document. A split will be made
(closing one HTML file and opening the next) before any paragraph with any of the selected styles. (May
be used in conjunction with Page break before.)

The list of styles offered may include some that are not listed by the word processor. This is because the
word  processor  creates  (hidden)  styles  which  are  variations  of  the  named  styles.  OpenOffice,  for
example,  creates  both  paragraph  and  text  styles  which  have names  of  the form P  (for  paragraph)
followed by a number or T (for text) followed by a number. The user of  Converter is advised  not to
select any of these generated styles as a place to make a split.17

4.4.3 Part titling ...

HTML files may have a title. eBK Builder uses these titles to create the table of contents for the ePUB
book. You may leave the specification of those titles until you are creating the ebook with Builder, but
where there are a large number of HTML files this can be tedious and the Part titling... option  allows

17 If Converter were only to be used with OpenOffice then it might be worth considering eliminating the generated 
styles from the list. However, Converter may well work with Open Text Documents produced with other systems, or
OpenOffice might change the format it uses for the naming of generated styles. It seems sensible, therefore, to 
include all used paragraph styles in the list and leave the discrimination to the user.
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you to specify what the titles of the HTML files should be.

The constructed titles have four elements one of which may be a number:

• the text before the number

• the number

• the text after the number

• the opening text of the HTML file

When you select Part titling ... you will be shown five panels like this:

Type the text you want before the number in the box below Before: and the text to appear after the
number in the box below After: then select the format of the number. Here are examples of the options:

• Decimal: 26

• Roman: xxvi

• ROMAN: XXVI

• Letter: z

• LETTER: Z

or if you do not want a number then select No number. This can be useful in giving a title to a single
page. If no selection is made then Decimal is assumed.

Tick (check) the box Append text if you want the text from the first paragraph to be appended. This is
useful when the chapter (for example) has a title. The text appended is limited to a maximum of 40
characters.

By default the first HTML file (...000.html) is assigned the number 1 and the next 2 and so on, replacing
the number by the equivalent Roman numeral or letter as indicated.

If you want the numbering to begin at some other part then type that number in the box below Start at
part no: remembering that the first part is numbered zero.

If you want two or more numberings within the same document (for example chapters and appendices)
then you can fill in more than one panel starting each numbering scheme with the desired part. Here is
an example:
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This gives the first part (...000.html) the title ‘Cover’; the second part (...001.html) the title ‘Title page’;
the third part (...002.html) the title ‘Author’s note’ and the remaining parts are given the titles: ‘Chapter
1’, ‘Chapter 2’, Chapter 3’ and so on. Appendices could be ‘numbered’ with letters by setting:

Before: Appendix

Selecting LETTER

Start at part no: 17 (where part 17 contains Appendix A, the file with name ... 017.html)

Note: eBK Builder allows the titles in HTML files to be overridden when creating the ePUB book.

4.5 The Fonts menu

An ePUB ebook can contain the specifications for fonts, or to be more accurate font faces. This means
that the ebook does not have to rely on the fonts it uses being available on the e-reader or computer on
which it is being viewed, but there may be restrictions. Certain fonts cannot freely be transferred to
another computer or computer-like device.

The first group of options on the fonts menu concern the fonts are available on your computer. The
second group sets the parameters which determine the sizes of displayed characters.

4.5.1 Link fonts ...

This option allows you to identify the folder which contains the fonts available on your computer. When
you identify the folder Converter scans the folder and constructs a list of the fonts that it can handle18 –
i.e. TrueType fonts – and ignores the others. Once such a list is established the conversion process will
copy the font files of all fonts used by the document being converted into a a fonts folder inside the
folder where the HTML and CSS files are placed. These fonts are then available to be embedded in an
ePUB book produced with eBK Builder. In the early stages of developing an ePUB book it is probably
wise not to link a fonts folder as all  your work will  be on the same computer where the fonts are

18 The limitation to TrueType fonts is determined by the limitations of Java.
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available and do not need to be embedded in the ePUB book.

It should be noted that fonts may be stored in several files, typically one for ‘regular’ plain text, one for
italic,  one for bold and one for  bold-italic.  All  such files are copied by  Converter.  Some fonts (e.g
Pristina) have only one file for the plain text. However, word processor may allow the user to display
(and  print)  what  looks  like  bold  or  italic  Pristina.  Such  effects  are  generated  rather  than  being
determined by a specification and are know as faux bold or italic. Such variations cannot be embedded
in an ePUB book and may not be available through an ereader. The user should consider the merit of
avoiding such faux variations.

4.5.2 Font folder is shared

If several separate ODT documents are being converted and used to create a single ePUB book <6.2>
then using a single font folder will  avoid duplication of  embedded fonts in the ePUB book.  Ticking
(checking) this option for each of the conversions will ensure that the same font folder is available for
all.

4.5.3 Break link

This breaks the link to the folder of available fonts (if one exists). If there is no link to such a folder then
a side effect of the conversion process is to delete the folder where font files are copied to and any files
in it, unless the Font folder is shared option has been selected (ticked/checked).

4.5.4 Use fixed point sizes

In most word processors the size of the displayed characters is set as a number of points19. This is not
necessarily the case in HTML where relative font sizes are normally used <2.2.3>. However, if you want
to use the font sizes specified in the ODT document then select this option, otherwise the algorithm
described earlier <2.2.3> will be applied.

4.5.5 Set font conversion values...

The conversion algorithm described in <2.2.3> by default converts point sizes to relative sizes using 13
points as the equivalent of medium and determining the ranges of point sizes converted to the other
relative sizes using the value 1.2 as the ratio between them. You can change these values by selecting
this option. Only a limited number of options for each value are given so that the results do not lead to
extremely small or extremely large displayed fonts. It is likely that you will have to experiment with the
different pairs of values until the HTML output is satisfactory.

4.6 The Options menu

4.6.1 Fill page width

As noted earlier Converter does not fix the page width <2.2.3>. However, if this option is not selected
(unchecked/unticked) then the HTML document will be given margins (within the space available) that
are proportionally equivalent to the margins in the original ODT document. By default this option  is
selected. Deselecting it will  introduce margins in the displayed HTML document, whether through a
browser or an ereader. On ereaders (which tend to have small screens) this may mean that the width of
displayed text is too narrow.

4.6.2 Tab replacement ...

There is no concept of a tab in HTML. Where a tab is indicated in the ODT document then this is

19 One point = 1/72 inch.
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replaced by the text set with this option. By default this text is a single space. To change it, select this
option and type a different text.

If  the text typed contains spaces then these will  be converted to non-breaking spaces in the HTML
document so that they are not ignored or collapsed into a single space.

4.6.3 Notes ...

Selecting this option allows you to change two options:

• Display reference as superscript

• Enclose reference in brackets

Notes, or to be more precise endnotes, are of three types:

• those derived from footnotes in the ODT document

• those derived from endnotes in the ODT document

• those derived from comments in the ODT document (optional)

The two options refer to the display of the number or symbol that is associated with the note. It can be
superscript (for example:  1 ) or normal (1) and in either case it can be enclosed in brackets ([ ... ]).
Either, both or neither of the option need be selected.

In all cases the reference in the text will be converted to a link which if clicked will take the user to the
corresponding endnote.

4.6.4 Include annotations

Annotations or comments as they are called in OpenOffice are not strictly part of the ODT document and
are (by  default)  ignored  by  Converter.  However,  if  these  are  to  be displayed in  the output  HTML
document then select (tick/check) this option and they will  be included as a further set of endnotes
referenced by the author’s initials and an identifying number.

4.7 The About menu

This gives information about the software.

4.7.1 ODT Converter <version number>

Gives brief information about the software but with options to see more complete information about the
warranty and the conditions under which the software may be used, copied, modified or distributed.

4.7.2 No warranty

Explains in details that the software comes with no warranty.

4.7.3 Conditions

Displays the full GNU Licence under which this software is made available, and the conditions under
which the software may be used, copied, modified or distributed.
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5 Using Builder

Before attempting to use Builder it is recommended that a destination folder is created.  Its name is
irrelevant but we shall call it  ePUB. The resulting ePUB ebook will be created in this folder and may be
copied or moved to wherever it is needed.

5.1 A first ebook

We will construct an ePUB ebook from the HTML documents created from the ODT document containing
the first three chapters of Charles Dickens’ Oliver Twist <3.2>.20 The 

There are three essential tasks:

1. assigning an identifier

2. assigning a title to the ebook

3. adding one or more HTML documents.

Launch  Builder by  browsing  to  where  eBK was  installed  and  double-clicking  eBKBuilder.jar.  The
following window will appear  (the version number in the title bar may be slightly different):

20 If you haven’t done this then return to the relevant section and do it now.
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5.1.1 The identifier

Every ePUB book must have an identifier. It is best if the identifier can be guaranteed to be unique. This
can be achieved in several ways. For example, if the ebook has an ISBN21 then that can be used. Because
web site addresses are unique it is possible to construct a unique identifier from a web site URL22. For
example eBK is produced by Senex Domum Digital which owns the web address:

senexdomum.co.uk

This can be turned into a unique identifier by adding a suffix (as in this example):

senexdomum.co.uk/ebooks/first

There does not need to be anything at that address,  it  is just a convenient way of  constructing an
identifier that you can guarantee is unique.

21 ISBN (International Standard Book Numbers) are allocated in each country by a designated authority. The ISBN of 
an ebook will be different from that of a printed version of the same book, just as the ISBN of a hardback edition 
differs from that of the paperback edition. It is relatively easy to apply for ISBNs but the use of ISBN usually entails 
supplying copies of the books to a number of institutions such as national libraries.

22 Uniform Resource Locator.
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5.1.2 Assigning an identifier

On the Content tab, type the identifier of the book in the box labelled:

Identifier:

This can be changed at any time.

5.1.3 The title

This is the title of the ebook which if it were a printed book would appear on the cover and on one of the
early pages in the book. This title has nothing to do with the titles of individual HTML documents that
are used to build the book. They also have titles which are used in the table of contents available when
the ebook is read.23

5.1.4 Assigning a title

On the Content tab, type the the title (for example, ‘Oliver Twist’) in the box next to the word

Title:

This can be changed at any time.

This title is the title of the whole book and should not be confused with the titles of individual content
files, even if there is only a single content file in the book it is necessary to specify a title for the ebook.

5.1.5 The HTML files

Several of these can be added one at a time. As they are added their validity is checked and an error
message is displayed with the nature of the error detected. Only the first error encountered is reported.
However, as we are produced the HTML files with Converter we have them all in a single folder with all
the other files needed. To do this click the button [Add from folder] and browse to the folder where the
HTML files created earlier by  Converter were placed. Select the folder name and click [Add]. The
Content tab should look something like:

23 When an HTML document is added to the ebook using eBK , eBK will display the title that it finds in the HTML 
document. It is an error not to have a title. However, if you wish the entry in the table of contents to be different 
from the title in the HTML document, eBK allows you to change it (without affecting the original HTML document)
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You may click on any of the documents listed on the left to display information about them in the right-
hand panel. If you look at all three in this way you will see that all three have the same title:

Oliver Twist: Chapters 1-3

These titles will be used to create the table of contents in the ePUB ebook – it would be better if they
were all  different.  You can change the titles of  each document by selecting it  on the left and click
[Change title]  at the bottom of the right-hand panel.  Do this.  (The illustration shows that title for
document.odt.002.html has been changed to Chapter III.)

It  is possible to have  Converter assign titles to the documents it creates rather than have to do it
individually at this stage <4.4.3>.

Each HTML file must have an ID (identifier) which is unique within the ePUB ebook. eBK allocates ID
systematically. They are never visible to the ebook reader and therefore it is unimportant what they are.

There is a minimal requirement for the Content Tab before you can move on to the Data Tab:

• the Identifier must not be empty

• the Title must not be empty
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there must be at least one valid Content File and no invalid Content files.

Once these criteria have all been met the Data tab is enabled and may be opened. You may return to the
Content tab to make changes or additions whenever you like. However, if the minimal requirement is
not met then the Data Tab will become inaccessible. Information on the Data tab will not be removed.

5.1.6 Saving your ebook specification

Before moving on it will be wise to save the work up to this point. An ePUB book in development can be
saved at any time. The file that is created when a save is carried out contains sufficient information to
restore the work at a later time This includes all the information you have specified while using  eBK
including references to all the files required to construct the ebook. It does not contain the HTML files
(content files) themselves. It is assumed that such files will still be available when the  specification is
opened and loaded into eBK. This method is used because it means what is stored is small. It also allows
modification to the HTML content files to be made independently and when the specification is opened
the new versions of the files will be used.

To save your work select  File >> Save. You can save the where you like and give it a name of your
choosing. The the internal format of the saved file is XML however its file type will be forced to be ebb .

After a successful ‘save’ you will see that bar across the top, just above the three tabs gives the name of
the file used. The words in parentheses will change if modifications are made to you book specification.

If  eBK is closed when the current specification has not been saved then you will  be warned. If you
launch eBK and wish to continue with a specification previously saved then select File >> Open.

5.1.7 On the Data tab

Having completed what is necessary for the Content tab, select the Data tab.

There are many items that may be completed on the Data tab. However, most of them are optional and
during the development of an ePUB ebook many of them can (and will be) left blank until late in the
process. Some of them may remain blank even when the book is finished.

For the purposes of this illustration we will deal mainly with the compulsory items. An explanation of the
others will be found later in this document <6.3>.

Three items will already have been completed for you. Two are merely copies of information from the
Content tab. The other is the current day’s date in the ePUB approved format.

It is compulsory that there must be at least one creator. To add a creator click [Add] at the bottom of the
empty list of Creators. You will be presented with a dialogue box with three items:

• Name:

• Name in format for indexing

• A pull-down list of types of creator.

Only the first and the last of these are required. The second one requires a little explanation. Suppose
the creator’s name is Annabel Xanthia Smith, and this is the way her name should normally appear. It
would be normal when citing a book or adding it to a catalogue or index to place the family name first so
that it appears (in this case) under S rather than A. So, if desired, the second item can be filled out with
(for example) Smith, Annabel Xanthia.

For the last of the three, most ebooks will select Author24.

Add the details of the creator of this book.

Should you wish to edit an individual creator you will need to [Remove] the existing entry in the list and
create a new, corrected, one. If you have more than one creator the order in which they are listed should

24 By default eBK offers a limited number of types of creator to choose from. There is a much larger list of recognised 
types is given in the MARC list which can be found at http://www.loc.gov/marc/relators/relaterm.html.
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be the same order that would be given on the title page of a printed book.

It is also necessary to specify the language of the ebook. This should be the language of the target
audience.  You  should  type the  recognised  code  for  the  language  in  the  Language  box.  These  are
typically two letter-codes, though there are three-letter codes and both can have a suffix to indicate the
variant of the language25. We shall use en-GB here to indicate ‘English as used in Great Britain’. You
probably know the code for your own language if you want to find out other codes then a good starting
place is, http://en.wikipedia.org/wiki/Language_code.

Once you have added a creator and specified the language then the Book tab will be enabled. Before
moving on to the Book tab let us consider a couple more items.

The Identifier (set on the Content tab) is:

senexdomum.co.uk/ebooks/first

Although not necessary it is good practice to indicate what scheme this identifier conforms to. The pull
down list gives four options DOI, ISBN, URI, URL. The above identifier matches the requirements for
URI so select URI. This and other options will be discussed in more detail later <6.3.1.1>.

The Event pull-down list offers some suggestions as to the event that is happening. You can type in your
own should you wish to.

The list headed Subjects (Keywords) offers a way of characterising the content, purpose or audience
for the book. At the moment there is no recommended list of options. In the case of our illustrative book
you may feel that ‘Victorian’ and ‘Extract’ might be appropriate additions to this list. Most ebook readers
allow users to search for books according to these subjects or keywords.

You may, of course wish to add further information, but as what has been described is more than enough
to meet the minimum requirements we can move on to the Book tab.

You may feel that this is a point at which you would like to save your work. Just select  File >> Save
your saved file will be updated with the changes you have made since the last save.

5.1.8 On the Book Tab

This is where the final stages occur.

The first step is to indicate the folder where the book should be saved. This is the referred to as the
Destination folder. Click [Destination] and browse for your ePUB folder. Select the ebook folder and
then click [Open].

Once a destination folder has been specified  [Build]  will be enabled. (The destination folder can be
changed later.)

Th eebook is  created in the  Destination  folder.  The same folder is used to hold intermediate files
produced in preparation for creating your ePUB ebook. By default these files are deleted when you close
eBK. However, if you use Explorer to inspect what is in inside the ebook folder before closing eBK you
will see these files.

The creation of the ePUB ebook file is carried out in two stages. First it is built and then it is packed.
The building of the ebook creates all the necessary files and the packing stage compresses those into a
single ePUB file. The name of the ePUB file will be the title of the book followed by .epub26.

To build the book, merely click [Build] button. If this is successful a list of files will appear in the left-
hand panel. Selecting a file in the left-hand panel will display information about that file. Much of what
is displayed is technical but it may help you to appreciate what has been created and be useful if the
outcome is not what you expected. The display shows the file’s contents. If this is long then only the first
part may be shown.

A successful build will cause [Pack] to be enabled. Even if the build is successful you may be given some

25 eBK makes no attempt to validate the language code.
26 Like any computer file the name of the file containing the ebook may be changed after creation.
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warnings. Warnings will not prevent you completing your ebook, but it may be that eBK has to provide
or select appropriate information. Complete the production of the ebook by clicking [Pack].

If  you  launch  eBK and  open  a  complete  specification  you  will  be  allowed  to  go  to  the  Book tab
immediately. However, you will find that you must build and pack the ebook again to re-create the ePUB
ebook.

The ebook you have created will be stored in a file with a name derived from the title of the ebook. So in
our example the file will have the name Oliver_Twist.epub with each space in the title replaced by an
underline.  (This  form of name, with no spaces,  is more suited to storage on the Internet.  You may,
however, choose to have a name with spaces as specified in the title of the ebook<6.1.2.2>.)

5.1.9 Reading the book

As you are interested in creating ePUB ebooks you probably have a means of reading such ebooks. This
will either be a special purpose device27 or software on your computer or other device (such as a mobile
phone with an appropriate app). Either open you new ebook with your reading software or transfer it to
your device and read it as you would any other ePUB ebook.

27 The  Wikipedia entry on ePUB has a list of compatible devices and software readers.
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6 Builder in detail

In this section every user action is described. In doing so some indication is given as to the purpose of
the function associated with the button or menu entry.

Below the menubar is a panel that extends the full width of the window. It displays the name of the file
associated  with  the  specification  being  developed.  Initially  it  will  show  New  (not  saved)  until  a
specification has been saved. If a specification has just been loaded (or just saved) then ‘saved’ will
appear in parentheses at the end of the file path, otherwise ‘not saved’ will be displayed. At the right-
hand end of the same panel is a small box giving the identifying letters of the options currently selected.

6.1 The menus

6.1.1 The File menu

6.1.1.1 New

This clears all the information from Builder in preparation for a new book specification. If the current
information in Builder has not been saved the user is warned.

6.1.1.2 Open...

Opens an existing book specification (stored in a file of type ebb using Save or Save as ...) and loads the
specification. If the current information in Builder has not been saved the user is warned. If it has then
it Builder will clear all information as if New had been selected.

6.1.1.3 Save ...

Saves the current information (the book specification) in Builder in a file of the same name as the file
from which the information was loaded using  Open. If no file has been specified since  Builder was
launched or since a new specification was started then this action becomes equivalent to Save as ...

6.1.1.4 Exit

Closes Builder. If the current information in Builder has not been saved the user is warned.

6.1.2 The Options menu

The status of each of these options is indicated in the small Options box near the top right-hand corner
of the Builder window.
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6.1.2.1 Delete intermediate files

When this is selected (D in the Options box) all the files that Builder creates as part of the building and
packing process are deleted once the ePUB book has been created. If you would like to inspect or save
these then unselect this option. (By default this is selected.)

6.1.2.2 No spaces in ePUB file name

When this is selected (N in the Options box) all final ePUB file will have a name derived from the title
you have given the ebook. However, each space in the title will have been replaced by an underline
character. If you prefer a file name with spaces (as in the given title) then unselect this option. (By
default this is selected.)

6.1.2.3 Zip file

When this option is selected (Z in the Options box) alongside the ePUB book produced a second file of
type zip is created. This is identical to the ePUB file (of type epub) but by making it of type zip the user
can open it with appropriate software and examine its contents.

6.1.3 The Fonts menu

If fonts are to be embedded in the ePUB book then Builder must know which fonts and where to find
the files holding them. The simplest way to do this is to have a single folder with all the necessary font
files in the folder and no others. Converter creates and populates such a folder, but the option remains
for the user to do this manually, or to modify the folder (created by Converter) or its contents.

6.1.3.1 Link folder ...

Allows the user to identify the folder containing files for the fonts to be embedded.

6.1.3.2 Unlink folder

Breaks any link to a folder of fonts that the user has established.

6.1.4 The Customise menu

Role is the only option (at the moment) on this menu and this will be discussed later <6.3.3.2>.

6.1.5 The About menu

This is, except for the reference to eBKBuilder,  the same as for Converter <4.7>.

6.2 The Content tab

The top part of the Content tab has two text boxes labelled Identifier and Title. Any text typed in these
boxes is in blue indicating that it can be edited directly by the user. We have already mentioned that the
text in the  Title box should be the overall title of the ebook, and that the identifier should try to be
unique <5.1.1>.

6.2.1 The left-hand panel

The left-hand panel is headed Content files (HTML) and lists the HTML files that have been added to the
ebook. These HTML files contain the readable content of the ebook. Further content files can be added
using [Add] at the bottom of the panel. Content files can be removed using [Remove].
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The order of the content files is the reading order. This can be changed using [Up] and [Down].When a
content file is added it is added to the bottom of the list.  In the situation where the ebook is to be
constructed from several HTML files produced in different ways then it may be useful to add them and
then rearrange them. Even when all the content files have been added from a single folder of files
produced by Converter there may be reasons for inserting content files in among those generated from
an ODT document.

6.2.2 The right-hand panel

The left-hand panel is interactive in that if the name of a content file is clicked then information about
that content file appears in the right-hand panel. If the content file exists and is valid then the following
information is displayed:

• ID – this is an identifier which unique within the ebook. It is a requirement of the ePUB standard
that this be the case. Builder generates these identifiers to ensure they are unique. As far as the
reader of the ebook is concerned they are irrelevant.

• File – this gives the full path of the HTML file holding the content.

• Title – this is the title of this content part (such as a chapter) that will appear in the table of
contents in the ebook. The title can be changed by clicking [Change title] at the bottom of the
right-hand panel.

• Stylesheet – the code in brackets is the identifier of the stylesheet (CSS file) linked to the HTML
(content file). This is followed by the name of the CSS file which must be in the same folder as
the content file.

• Image – If the content file includes images then this entry will be present with the identifier
code of the image, the path of file containing the image relative to the location of the content
file, the size of the image in pixels (width,height). Below the entry will be a thumbnail of the
image.

• Opening –  This gives the unformatted text that  begins the content file.  This helps the user
recognise which part of the content is held in the file. (The text is not laid out as it will be in the
ebook.)

If a content file does not exist – it may have been deleted since the specification was saved – or is in
some detectable way invalid then an error message will be displayed in the right-hand panel (at the
bottom) with an indication of a possible solution.

6.3 The Data tab

The  Data  tab  allows  the  user  to  specify  information  about  the  ebook  being  created.  Most  of  the
information is optional, but the ePUB format allows for the inclusion of such data and there will be good
reasons for including more than the minimal necessary to comply with the ePUB specification.

Many of  these item provide information that  is  expected (but not  required) by the Open Packaging
Format28 which is part of the ePUB specification.

The Data tab has several independent input areas, we will deal with in three sections: the top left area,
the top right area, and the three similar areas in the lower half of the tab.

6.3.1 The top left – Identifier, Scheme, language, Title, Subtitle and Rights

The illustration shows the top left of the Data tab with the required items (for our example) completed.
The information about  Identifier and  Title are automatically  taken from the  Content tab and any
changes required must be made there.

28 Details of the Open Packaging Format can be found at http://idpf.org/epub/20/spec/OPF_2.0.1_draft.htm
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6.3.1.1 Scheme

The  pull-down  list  labelled  Scheme.  This  gives  you  the  opportunity  to  indicate  the  format  of  the
identifier you have given your book. There is no definitive list of valid values indicated in the ePUB
specification29 which leaves it open to you to type in something appropriate. However, there are four
suggestions in the pull-down list:

• DOI (Digital Object Identifier www.doi.org)

• ISBN (International Standard Book Number www.isbn-international.org)

• URI (Uniform Resource Identifier)

• URL (Uniform Resource Locator)

A URL is what we less formally refer to as a web address. A URL is a specific kind of URI and it is
difficult to find a straightforward explanation of the distinction which might affect the way they are used
here. Essentially the difference is that in a URL there is sufficient information to enable someone to
locate the resource (an HTMl document, a picture or other file), whereas a URI merely identifies it. If
the string:

senexdomum.co.uk/ebooks/first

is sufficient to locate the resource then it is a URL . However, if it only provides a way of identifying the
resource then it is a URI. At the moment it is a URI. If it were extended to become:

http://senexdomum.co.uk/ebooks/first.epub

then  it  could  be  a  URL  if  the  identified  resource  can  be  found  (and  accessed)  through  the  http

29 The ePUB specification is is made up of three separate specifications together with references to other 
specifications such as XML. Further information can be found at http://idpf.org/epub/201
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(Hypertext Transfer Protocol) that is by using a web browser using the information given.30

6.3.1.2 Language

This is required.

The recognised schemes for identifying languages is not straightforward. A number of schemes have
existed  and  a  number  are  recognised  and  in  current  use31.  The  ePUB standard  makes  no  specific
requirement as to which scheme is used though it is advisable to use one of the currently recognised
schemes.

6.3.1.3 Subtitle

This is optional and can be any line of text.

6.3.1.4 Rights

The obvious part of the rights is the copyright statement. This is in two parts:a year and a the name of a
person or organisation. On the Data tab type the year in the text box to the right of the Year and the
name to the right of he copyright sign (©). The year should be four digits but the name can be any text.

The larger text box to the alongside Rights can be filled with as much text as is required to describe the
detail  of  the rights  associated with  the ebook being produced.  (A scroll  bar will  appear if  the text
extends beyond the default area.)

6.3.2 The top-right area – Publisher, Date, Event, Source, Description

30 This explanation should not be taken as technically definitive. It is only indicative. URIs do not need to have the 
appearance of web addresses there are other ways of forming URIs which we cannot go into here.

31 See, for example, http://en.wikipedia.org/wiki/Language_code

Date of most recent modification: 2013-09-20 36/48

Data tab – top right area



eBK User Guide

6.3.2.1 Publisher

The name of the publisher. Only a single line is allowed by Builder but this could include brief contact
information. However, it is expected that the content of the ebook itself will have full information about
the publisher.

6.3.2.2 Date

This is always set automatically to the current date.

6.3.2.3 Event

Builder offers three possible events: publication, creation and modification. No strict interpretation of
these options is offered. Again more detailed information is expected to be given in the content of the
ebook.

6.3.2.4 Source

This is a place where information about earlier sources that have been used in creating the content can
be given. Again more detailed information is expected to be given in the content of the ebook.

6.3.2.5 Description

This is place where the publication – the ebook – can be described. The user may type as much text as is
thought necessary.  (A scroll bar will appear if the text extends beyond the default area.)

6.3.3 Creators, Contributors and Subjects

6.3.3.1 Creators and contributors

The distinction between Creators and Contributors is subjective. Clearly an author is a creator, but in
(for instance) a collection of previously published works, the editor may be seen as a creator (by writing
an  introduction  or  commentary)  but  the  authors  of  the  individual  works  could  be  considered  as
contributors. No firm guidance can be given on this topic.

As far as Builder is concerned the method of specifying creators and contributors is the same. The only
thing to notice is that there must be at least one creator.
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To add a creator or a contributor click [Add] at the bottom of the appropriate panel. In each case you
will be presented with the following pop up like the following:

Only the first and the last of these items are required.

The second one requires a little explanation. Suppose the creator’s name is Annabel Xanthia Smith,
and this is the way her name should normally appear. It would be normal when citing a book or adding it
to a catalogue or index to place the family name first so that it appears (in this case) under S rather than
A. So, if desired, the second item can be filled out with (for example) Smith, Annabel Xanthia.

The  drop-down  list  for  the  Role  of  the  creator  (or  contributor)  gives  an  extensive,  but  not
comprehensive, list of possible roles32.

6.3.3.2 Adding a role

If there is a role that is not given in the default list then you can add it as follows:

32 The list in Builder is taken from the Open Packaging Format specification 
(http://idpf.org/epub/20/spec/OPF_2.0.1_draft.htm). A longer list can be found at 

Date of most recent modification: 2013-09-20 38/48



eBK User Guide

Select Customisation >> Role >> Add and then give the title of the role and a suitable three letter
abbreviation. Ideally this extra role should be one that is recognised in the MARC list 33, but this is not
compulsory. The process of adding a role results in a file called eBK-Roles.xml being created in the same
folder as eBKBuilder.jar. This new file contains all the roles now recognised by Builder: the new one and
the default list and the new customised list is available to all the ebooks you produce with Builder.

The two other options under the Role submenu are Delete and Revert. Delete removes a selected role,
Revert returns the list to the default list. Revert has two modes:

1. the file eBK-Roles.xml is deleted

2. the file eBK-Roles.xml is moved to another location on your computer.

You will be offered a choice between these two. The effect of both is to return the list of available roles
to the default list.

If you move the file eBK-Roles.xml then you can reinstate the list it contains by moving (or copying) the
file into the folder containing  eBKBuilder.jar.

6.3.3.3 Subjects (also called keywords)

These are words or short phrases that will characterise the publication and aid anyone searching for it.
There is no restriction on what a subject or keyword can be (or their number) though Builder only allows
a line of text for each. To add or remove a subject/keyword click either [Add] or  [Remove] at the
bottom of the Subject (Keywords) panel.

6.3.3.4 The Up and Down buttons

On all three panels these buttons can be used to change the order of the entries. For creators and
contributors  the  order  may  be  significant:  alphabetical,  or  seniority  or  some  other  reason.  For
subjects/keywords the order is unlikely to matter.

6.4 The Book tab

The Book tab allows you to do three things:

• specify  where  the  ebook  is  to  be  created  –  the  Destination  folder.  To  do  this  click
[Destination] and browse for the folder and [Select] it.

• build  the ePUB book –  this  creates all  the  files that  need to  be placed in the in the ePUB
package. To do this click  [Build]. This button will not be enabled until a destination folder is
specified. After a successful build the list of files to be packaged will appear in the left-hand
panel. This list is active and clicking the entry for a particular file will display information and
the first part of the contents of the file in the right-hand panel.

• pack the the ePUB book – this produces the single file which is the package containing all the
files that constitute the ebook. Most of these files are compressed.  To do this click [Pack]. This
button will not be enabled until a successful build has been accomplished. The list in the left-
hand panel will remain but is no longer active. The right-hand panel gives the name of the ePUB
package and the list of files in the package with information about how each is stored.

33 The MARC list can be found at http://www.loc.gov/marc/relators/relaterm.html
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7 The GNU Free Document License

                GNU Free Documentation License
                 Version 1.3, 3 November 2008

 Copyright (C) 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc.
     <http://fsf.org/>
 Everyone is permitted to copy and distribute verbatim copies
 of this license document, but changing it is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other
functional and useful document "free" in the sense of freedom: to
assure everyone the effective freedom to copy and redistribute it,
with or without modifying it, either commercially or noncommercially.
Secondarily, this License preserves for the author and publisher a way
to get credit for their work, while not being considered responsible
for modifications made by others.

This License is a kind of "copyleft", which means that derivative
works of the document must themselves be free in the same sense.  It
complements the GNU General Public License, which is a copyleft
license designed for free software.

We have designed this License in order to use it for manuals for free
software, because free software needs free documentation: a free
program should come with manuals providing the same freedoms that the
software does.  But this License is not limited to software manuals;
it can be used for any textual work, regardless of subject matter or
whether it is published as a printed book.  We recommend this License
principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that
contains a notice placed by the copyright holder saying it can be
distributed under the terms of this License.  Such a notice grants a
world-wide, royalty-free license, unlimited in duration, to use that
work under the conditions stated herein.  The "Document", below,
refers to any such manual or work.  Any member of the public is a
licensee, and is addressed as "you".  You accept the license if you
copy, modify or distribute the work in a way requiring permission
under copyright law.
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A "Modified Version" of the Document means any work containing the
Document or a portion of it, either copied verbatim, or with
modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of
the Document that deals exclusively with the relationship of the
publishers or authors of the Document to the Document's overall
subject (or to related matters) and contains nothing that could fall
directly within that overall subject.  (Thus, if the Document is in
part a textbook of mathematics, a Secondary Section may not explain
any mathematics.)  The relationship could be a matter of historical
connection with the subject or with related matters, or of legal,
commercial, philosophical, ethical or political position regarding
them.

The "Invariant Sections" are certain Secondary Sections whose titles
are designated, as being those of Invariant Sections, in the notice
that says that the Document is released under this License.  If a
section does not fit the above definition of Secondary then it is not
allowed to be designated as Invariant.  The Document may contain zero
Invariant Sections.  If the Document does not identify any Invariant
Sections then there are none.

The "Cover Texts" are certain short passages of text that are listed,
as Front-Cover Texts or Back-Cover Texts, in the notice that says that
the Document is released under this License.  A Front-Cover Text may
be at most 5 words, and a Back-Cover Text may be at most 25 words.

A "Transparent" copy of the Document means a machine-readable copy,
represented in a format whose specification is available to the
general public, that is suitable for revising the document
straightforwardly with generic text editors or (for images composed of
pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or
for automatic translation to a variety of formats suitable for input
to text formatters.  A copy made in an otherwise Transparent file
format whose markup, or absence of markup, has been arranged to thwart
or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount
of text.  A copy that is not "Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain
ASCII without markup, Texinfo input format, LaTeX input format, SGML
or XML using a publicly available DTD, and standard-conforming simple
HTML, PostScript or PDF designed for human modification.  Examples of
transparent image formats include PNG, XCF and JPG.  Opaque formats
include proprietary formats that can be read and edited only by
proprietary word processors, SGML or XML for which the DTD and/or
processing tools are not generally available, and the
machine-generated HTML, PostScript or PDF produced by some word
processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself,
plus such following pages as are needed to hold, legibly, the material
this License requires to appear in the title page.  For works in
formats which do not have any title page as such, "Title Page" means
the text near the most prominent appearance of the work's title,
preceding the beginning of the body of the text.
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The "publisher" means any person or entity that distributes copies of
the Document to the public.

A section "Entitled XYZ" means a named subunit of the Document whose
title either is precisely XYZ or contains XYZ in parentheses following
text that translates XYZ in another language.  (Here XYZ stands for a
specific section name mentioned below, such as "Acknowledgements",
"Dedications", "Endorsements", or "History".)  To "Preserve the Title"
of such a section when you modify the Document means that it remains a
section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which
states that this License applies to the Document.  These Warranty
Disclaimers are considered to be included by reference in this
License, but only as regards disclaiming warranties: any other
implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either
commercially or noncommercially, provided that this License, the
copyright notices, and the license notice saying this License applies
to the Document are reproduced in all copies, and that you add no
other conditions whatsoever to those of this License.  You may not use
technical measures to obstruct or control the reading or further
copying of the copies you make or distribute.  However, you may accept
compensation in exchange for copies.  If you distribute a large enough
number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and
you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have
printed covers) of the Document, numbering more than 100, and the
Document's license notice requires Cover Texts, you must enclose the
copies in covers that carry, clearly and legibly, all these Cover
Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on
the back cover.  Both covers must also clearly and legibly identify
you as the publisher of these copies.  The front cover must present
the full title with all words of the title equally prominent and
visible.  You may add other material on the covers in addition.
Copying with changes limited to the covers, as long as they preserve
the title of the Document and satisfy these conditions, can be treated
as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit
legibly, you should put the first ones listed (as many as fit
reasonably) on the actual cover, and continue the rest onto adjacent
pages.

If you publish or distribute Opaque copies of the Document numbering
more than 100, you must either include a machine-readable Transparent
copy along with each Opaque copy, or state in or with each Opaque copy
a computer-network location from which the general network-using
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public has access to download using public-standard network protocols
a complete Transparent copy of the Document, free of added material.
If you use the latter option, you must take reasonably prudent steps,
when you begin distribution of Opaque copies in quantity, to ensure
that this Transparent copy will remain thus accessible at the stated
location until at least one year after the last time you distribute an
Opaque copy (directly or through your agents or retailers) of that
edition to the public.

It is requested, but not required, that you contact the authors of the
Document well before redistributing any large number of copies, to
give them a chance to provide you with an updated version of the
Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under
the conditions of sections 2 and 3 above, provided that you release
the Modified Version under precisely this License, with the Modified
Version filling the role of the Document, thus licensing distribution
and modification of the Modified Version to whoever possesses a copy
of it.  In addition, you must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct
   from that of the Document, and from those of previous versions
   (which should, if there were any, be listed in the History section
   of the Document).  You may use the same title as a previous version
   if the original publisher of that version gives permission.
B. List on the Title Page, as authors, one or more persons or entities
   responsible for authorship of the modifications in the Modified
   Version, together with at least five of the principal authors of the
   Document (all of its principal authors, if it has fewer than five),
   unless they release you from this requirement.
C. State on the Title page the name of the publisher of the
   Modified Version, as the publisher.
D. Preserve all the copyright notices of the Document.
E. Add an appropriate copyright notice for your modifications
   adjacent to the other copyright notices.
F. Include, immediately after the copyright notices, a license notice
   giving the public permission to use the Modified Version under the
   terms of this License, in the form shown in the Addendum below.
G. Preserve in that license notice the full lists of Invariant Sections
   and required Cover Texts given in the Document's license notice.
H. Include an unaltered copy of this License.
I. Preserve the section Entitled "History", Preserve its Title, and add
   to it an item stating at least the title, year, new authors, and
   publisher of the Modified Version as given on the Title Page.  If
   there is no section Entitled "History" in the Document, create one
   stating the title, year, authors, and publisher of the Document as
   given on its Title Page, then add an item describing the Modified
   Version as stated in the previous sentence.
J. Preserve the network location, if any, given in the Document for
   public access to a Transparent copy of the Document, and likewise
   the network locations given in the Document for previous versions
   it was based on.  These may be placed in the "History" section.
   You may omit a network location for a work that was published at
   least four years before the Document itself, or if the original
   publisher of the version it refers to gives permission.
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K. For any section Entitled "Acknowledgements" or "Dedications",
   Preserve the Title of the section, and preserve in the section all
   the substance and tone of each of the contributor acknowledgements
   and/or dedications given therein.
L. Preserve all the Invariant Sections of the Document,
   unaltered in their text and in their titles.  Section numbers
   or the equivalent are not considered part of the section titles.
M. Delete any section Entitled "Endorsements".  Such a section
   may not be included in the Modified Version.
N. Do not retitle any existing section to be Entitled "Endorsements"
   or to conflict in title with any Invariant Section.
O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or
appendices that qualify as Secondary Sections and contain no material
copied from the Document, you may at your option designate some or all
of these sections as invariant.  To do this, add their titles to the
list of Invariant Sections in the Modified Version's license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled "Endorsements", provided it contains
nothing but endorsements of your Modified Version by various
parties--for example, statements of peer review or that the text has
been approved by an organization as the authoritative definition of a
standard.

You may add a passage of up to five words as a Front-Cover Text, and a
passage of up to 25 words as a Back-Cover Text, to the end of the list
of Cover Texts in the Modified Version.  Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or
through arrangements made by) any one entity.  If the Document already
includes a cover text for the same cover, previously added by you or
by arrangement made by the same entity you are acting on behalf of,
you may not add another; but you may replace the old one, on explicit
permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License
give permission to use their names for publicity for or to assert or
imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this
License, under the terms defined in section 4 above for modified
versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and
list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and
multiple identical Invariant Sections may be replaced with a single
copy.  If there are multiple Invariant Sections with the same name but
different contents, make the title of each such section unique by
adding at the end of it, in parentheses, the name of the original
author or publisher of that section if known, or else a unique number.
Make the same adjustment to the section titles in the list of
Invariant Sections in the license notice of the combined work.
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In the combination, you must combine any sections Entitled "History"
in the various original documents, forming one section Entitled
"History"; likewise combine any sections Entitled "Acknowledgements",
and any sections Entitled "Dedications".  You must delete all sections
Entitled "Endorsements".

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other
documents released under this License, and replace the individual
copies of this License in the various documents with a single copy
that is included in the collection, provided that you follow the rules
of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and
distribute it individually under this License, provided you insert a
copy of this License into the extracted document, and follow this
License in all other respects regarding verbatim copying of that
document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate
and independent documents or works, in or on a volume of a storage or
distribution medium, is called an "aggregate" if the copyright
resulting from the compilation is not used to limit the legal rights
of the compilation's users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not
apply to the other works in the aggregate which are not themselves
derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these
copies of the Document, then if the Document is less than one half of
the entire aggregate, the Document's Cover Texts may be placed on
covers that bracket the Document within the aggregate, or the
electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole
aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may
distribute translations of the Document under the terms of section 4.
Replacing Invariant Sections with translations requires special
permission from their copyright holders, but you may include
translations of some or all Invariant Sections in addition to the
original versions of these Invariant Sections.  You may include a
translation of this License, and all the license notices in the
Document, and any Warranty Disclaimers, provided that you also include
the original English version of this License and the original versions
of those notices and disclaimers.  In case of a disagreement between
the translation and the original version of this License or a notice
or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements",
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"Dedications", or "History", the requirement (section 4) to Preserve
its Title (section 1) will typically require changing the actual
title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document
except as expressly provided under this License.  Any attempt
otherwise to copy, modify, sublicense, or distribute it is void, and
will automatically terminate your rights under this License.

However, if you cease all violation of this License, then your license
from a particular copyright holder is reinstated (a) provisionally,
unless and until the copyright holder explicitly and finally
terminates your license, and (b) permanently, if the copyright holder
fails to notify you of the violation by some reasonable means prior to
60 days after the cessation.

Moreover, your license from a particular copyright holder is
reinstated permanently if the copyright holder notifies you of the
violation by some reasonable means, this is the first time you have
received notice of violation of this License (for any work) from that
copyright holder, and you cure the violation prior to 30 days after
your receipt of the notice.

Termination of your rights under this section does not terminate the
licenses of parties who have received copies or rights from you under
this License.  If your rights have been terminated and not permanently
reinstated, receipt of a copy of some or all of the same material does
not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the
GNU Free Documentation License from time to time.  Such new versions
will be similar in spirit to the present version, but may differ in
detail to address new problems or concerns.  See
http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number.
If the Document specifies that a particular numbered version of this
License "or any later version" applies to it, you have the option of
following the terms and conditions either of that specified version or
of any later version that has been published (not as a draft) by the
Free Software Foundation.  If the Document does not specify a version
number of this License, you may choose any version ever published (not
as a draft) by the Free Software Foundation.  If the Document
specifies that a proxy can decide which future versions of this
License can be used, that proxy's public statement of acceptance of a
version permanently authorizes you to choose that version for the
Document.

11. RELICENSING

"Massive Multiauthor Collaboration Site" (or "MMC Site") means any
World Wide Web server that publishes copyrightable works and also
provides prominent facilities for anybody to edit those works.  A
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public wiki that anybody can edit is an example of such a server.  A
"Massive Multiauthor Collaboration" (or "MMC") contained in the site
means any set of copyrightable works thus published on the MMC site.

"CC-BY-SA" means the Creative Commons Attribution-Share Alike 3.0 
license published by Creative Commons Corporation, a not-for-profit 
corporation with a principal place of business in San Francisco, 
California, as well as future copyleft versions of that license 
published by that same organization.

"Incorporate" means to publish or republish a Document, in whole or in 
part, as part of another Document.

An MMC is "eligible for relicensing" if it is licensed under this 
License, and if all works that were first published under this License 
somewhere other than this MMC, and subsequently incorporated in whole or 
in part into the MMC, (1) had no cover texts or invariant sections, and 
(2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site
under CC-BY-SA on the same site at any time before August 1, 2009,
provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of
the License in the document and put the following copyright and
license notices just after the title page:

    Copyright (c)  YEAR  YOUR NAME.
    Permission is granted to copy, distribute and/or modify this document
    under the terms of the GNU Free Documentation License, Version 1.3
    or any later version published by the Free Software Foundation;
    with no Invariant Sections, no Front-Cover Texts, and no Back-Cover 
Texts.
    A copy of the license is included in the section entitled "GNU
    Free Documentation License".

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts,
replace the "with...Texts." line with this:

    with the Invariant Sections being LIST THEIR TITLES, with the
    Front-Cover Texts being LIST, and with the Back-Cover Texts being 
LIST.

If you have Invariant Sections without Cover Texts, or some other
combination of the three, merge those two alternatives to suit the
situation.

If your document contains nontrivial examples of program code, we
recommend releasing these examples in parallel under your choice of
free software license, such as the GNU General Public License,
to permit their use in free software.
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